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This is the safety alert symbol. It is used to alert you to potential personal injury hazards.
IMPORTAN Obey all safety messages that follow this symbol to avoid possible injury or death.
¢ DANGER—Indicates a hazardous situation which, if not avoided, will result in
death or serious injury.
¢ WARNING—Indicates a hazardous situation which, if not avoided, could
DEF| N |T|ONS result in death or serious injury.
¢ CAUTION—Indicates a hazardous situation which, if not avoided, could result
in minor or moderate injury.
e NOTICE—Indicates a hazard that could result in property damage only
(including damage to the control).
¢ IMPORTANT—Designates an operating tip or maintenance suggestion.

The engine, turbine, or other type of prime mover should be equipped with an
overspeed shutdown device to protect against runaway or damage to the prime
mover with possible personal injury, loss of life, or property damage.

The overspeed shutdown device must be totally independent of the prime mover
control system. An overtemperature or overpressure shutdown device may also
be needed for safety, as appropriate.

installing, operating, or servicing this equipment. Practice all plant and safety instructions and

f Read this entire manual and all other publications pertaining to the work to be performed before
precautions. Failure to follow instructions can cause personal injury and/or property damage.

This publication may have been revised or updated since this copy was produced. To verify that
A you have the latest revision, be sure to check the Woodward website:
www.woodward.com/pubs/current.pdf
The revision level is shown at the bottom of the front cover after the publication number. The
latest version of most publications is available at:
www.woodward.com/publications
If your publication is not there, please contact your customer service representative to get the
latest copy.

electrical, or other operating limits may cause personal injury and/or property damage, including
damage to the equipment. Any such unauthorized modifications: (i) constitute "misuse" and/or
"negligence" within the meaning of the product warranty thereby excluding warranty coverage
for any resulting damage, and (ii) invalidate product certifications or listings.

To prevent damage to a control system that uses an alternator or battery-charging
NO TICE device, make sure the charging device is turned off before disconnecting the

battery from the system.

f Any unauthorized modifications to or use of this equipment outside its specified mechanical,

To prevent damage to electronic components caused by improper handling, read
NOTICE and observe the precautions in Woodward manual 82715, Guide for Handling and

Protection of Electronic Controls, Printed Circuit Boards, and Modules.

| Revisions—Text changes are indicated by a black line alongside the text.

Woodward Governor Company reserves the right to update any portion of this publication at any time. Information
provided by Woodward Governor Company is believed to be correct and reliable. However, no responsibility
is assumed by Woodward Governor Company unless otherwise expressly undertaken.

© Woodward 2009
All Rights Reserved
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Electrostatic Discharge Awareness

All electronic equipment is static-sensitive, some components more than others.
To protect these components from static damage, you must take special
precautions to minimize or eliminate electrostatic discharges.

Follow these precautions when working with or near the control.

1. Before doing maintenance on the electronic control, discharge the static
electricity on your body to ground by touching and holding a grounded metal
object (pipes, cabinets, equipment, etc.).

2. Avoid the build-up of static electricity on your body by not wearing clothing
made of synthetic materials. Wear cotton or cotton-blend materials as much
as possible because these do not store static electric charges as much as
synthetics.

3. Keep plastic, vinyl, and Styrofoam materials (such as plastic or Styrofoam
cups, cup holders, cigarette packages, cellophane wrappers, vinyl books or
folders, plastic bottles, and plastic ash trays) away from the control, the
modules, and the work area as much as possible.

4. Do not remove the printed circuit board (PCB) from the control cabinet
unless absolutely necessary. If you must remove the PCB from the control
cabinet, follow these precautions:

e Do not touch any part of the PCB except the edges.

. Do not touch the electrical conductors, the connectors, or the
components with conductive devices or with your hands.

e  When replacing a PCB, keep the new PCB in the plastic anti-static
protective bag it comes in until you are ready to install it. Immediately
after removing the old PCB from the control cabinet, place it in the anti-
static protective bag.

To prevent damage to electronic components caused by
improper handling, read and observe the precautions in
Woodward manual 82715, Guide for Handling and
Protection of Electronic Controls, Printed Circuit Boards,
and Modules.
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Chapter 1.

General Information
]

System Basics

APECS 500 is a single speed electronic engine governor that combines the
convenience of manual adjustments with the flexibility of a computer-based calibration
tool. Electrical connections consist of six wires to battery, actuator and magnetic engine
speed pickup via a Euro-style terminal strip. For most applications, APECS 500 can be
connected and adjusted with simple hand tools. For more advanced features, the
calibration tool provides user-friendly access.

As shipped from the factory, APECS 500 can be manually adjusted for stable operation
on most applications that supply a mag pickup frequency of 2500 to 5000 Hz.
Optionally, the user may attach the standard APECS calibration tool (ACT) to gain
access to a number of user-adjustable features including:

 Frequency range (200-15,000 Hz) — —
e Synchronized speed sampling

e Proportional, Integral and Derivative gains
(Gain potentiometer affects all three)

e Overspeed shutdown and delay
e Underspeed shutdown and delay

(ollls———
| WowoODWARD

e Crank-to-run transition speed ié%&.;, H

e  Warm-up speed and time
e Start-up gains
o Offset to actuator command

e Battery voltage compensation

In the event of a fault, APECS 500 provides helpful diagnostic information with an
onboard status lamp. Additionally, the ACT may be used to access current and historic
fault codes.

APECS is an acronym for Advanced Proportional Engine Control System. It provides a
means of controlling engine speed by adjusting the fuel control lever with an actuator.
The heart of the system is a powerful microcontroller that processes the signal received
from a speed sensor and compares it to the desired speed setting.

The output of the controller is a pulse-width modulated (PWM) signal that drives a
precision proportional actuator connected to the engine’s fuel control lever. The
actuator converts the signal to an output shaft position, proportional to the duty cycle of
the pulse-width modulated signal.

APECS 500 provides isochronous engine governing (i.e., engine speed is maintained
at the commanded setting, regardless of load) through a wide speed range. APECS is
suitable for use on both compression ignition (diesel) and spark ignition (gasoline,
CNG, LPG) engines.

Woodward developed the APECS system for a variety of on- and off-highway
applications. Typical applications include generator sets, compressors, construction
machinery and farm vehicles.

Woodward 1
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Figure 1. APECS Engine Control System

The engine, turbine, or other type of prime mover
should be equipped with an overspeed shutdown device
to protect against runaway or damage to the prime
mover with possible personal injury, loss of life, or

The overspeed shutdown device must be totally
independent of the prime mover control system. An

overtemperature or overpressure shutdown device may
also be needed for safety, as appropriate.

System Components

The three components required to install an APECS 500 governor on an engine are the
APECS 500 controller, speed sensor, and actuator. Each component contributes to the
overall performance of the system and shortcomings in any of the components will
detract from total system performance. Optionally, the All-purpose Calibration Tool
(ACT) may be used to customize operation.

APECS Controller

The APECS 500 series controller is a single-speed
electronic engine governor that provides a means of
controlling and limiting engine speed by adjusting the
fuel control lever with a proportional actuator. APECS
500 will maintain fixed engine RPM regardless of load
provided that the engine’s available power is not
exceeded (i.e., isochronous operation).

The APECS 500 controller has a multi-turn
potentiometer for speed adjustment and a single turn potentiometer for gain adjustment.
A serial interface is provided for additional adjustments with the ACT. The controller has
six Euro-style screw terminals for:

e Battery Positive and Negative (9-30 Vdc). Reverse voltage protected.

Woodward 2
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e Actuator Positive and Negative (6A continuous). Short circuit protected.
e Magnetic Pickup (MPU) Positive and Negative (2 Vac minimum at 1000 Hz)

Provided that the MPU frequency is compatible with the engine application, setup
consists of the following:

1. Set gain potentiometer to center of travel (5). The speed set potentiometer
should be set to the minimum speed (fully counterclockwise) position.

2. Apply power to controller. The status LED should turn on for one second,
indicating normal operation.

3. Crank engine. The status LED should turn on continuously indicating a good
speed signal from the MPU. If not, check the MPU installation and wiring. If LED
immediately begins to flash a two code (indicating engine overspeed), increase
the desired speed setting by turning the multi-turn speed set potentiometer
several turns clockwise. Repeat this crank and adjust process until the engine
starts.

4. Adjust speed setpoint until desired speed is achieved. If the engine speed will not
settle down, turn the gain potentiometer counterclockwise until stable
performance results.

5. Once the desired speed setpoint is achieved, adjust gain for optimal performance
at all loads. In general, this amounts to increasing the gain as much as possible
without inducing oscillation under any load.

Speed Sensor

APECS 500 monitors engine speed continuously
using a magnetic pickup (MPU) which detects
the passing of teeth on an engine driven gear
(e.g., flywheel). The frequency of the voltage
generated by the MPU is proportional to engine
RPM.

Actuator

The actuator converts a pulse-width modulated signal received from the controller to an
output shaft position proportional to the duty cycle of the pulse-width modulated signal.

The actuator is mounted on the engine and
connected to the control lever by a mechanical
linkage.

NOTE: On spark ignition engines, the control lever
is usually the throttle lever. On compression
ignition engines (diesels), the control lever is
usually one of the mechanical governor levers
(either shutoff or governor).

Woodward 3
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Linkage

The linkage connects the actuator shaft to the
engine control lever. A good linkage allows for
misalignments and contributes to accurate, stable
and responsive performance with minimal play or
friction.

All-purpose Calibration Tool (ACT)

ACT is a PC (personal computer) based software calibration
and monitoring tool. ACT is designed specifically for use with
engines equipped with the APECS 500 controller. The tool
can be run on any IBM compatible computer that meets the
requirements listed in “ACT Installation” in Chapter 4.

Once the APECS 500 controller has been programmed, ACT
may be disconnected. The APECS 500 unit will continue to
operate normally with ACT either connected or disconnected.

Calibration Tool 7.3

The scope of this manual does not include
selection and installation of speed sensors,
actuators, or linkages that Woodward offers for
use with the APECS system. Information is
available on our website at www.woodward.com.

NOTICE

NOTICE and potentiometers is application dependent.
Please contact Woodward customer service for

information specific to your application.

_ The need for sub-components such as switches

Woodward 4
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Chapter 2.

SBecifications & Dimensions

Specifications

Ambient Operating Temperature | -40 to 85°C (-40 to 185°F)

Battery Voltage | 9-30 Vdc, reverse voltage protected

Electro-magnetic Compatibility | 30 V/m 2-1000 MHz

Magnetic Pickup | 2 Vac minimum @ 1000 Hz

Actuator Output®* | 6 A max (PWM)

Dimensions
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APECS 500 Electronic Engine Controller

Chapter 3.

Installation
]

Take adequate protection to ensure personal and equipment safety and follow the
suggested installation sequence given below:

Install main components:

Review Wiring page 6
Controller page 8
Speed Sensor page 10

Actuator & Linkage page 10

Wiring Guidelines

APECS 500 has six Euro-style terminals for external connections. To use:

A wDdPE

Loosen the terminals with a small blade screwdriver
Strip wire

Insert wire into terminal hole

Tighten terminal with a small blade screwdriver

Wiring Procedure

Refer to Figures 2 & 3 and Tables 1 & 2 to install the system and
subcomponents.

Mount the unit in a location where the effects of vibration and temperature are
within the specified range. Operating temperature: -40° C to +85° C (-40° F to
+185° F); vibration: 6 G’s from 40 to 2000 Hz. (See Figure 2 for controller
dimensions.)

Power leads are to be connected directly to a switched power source (i.e.,
battery). Use of a 10 amp, slow-blow fuse is recommended in the battery
(positive) wire.

Use shielded cable for external speed signal source. Shields should be
connected to the battery ground wire at one end only.

Use of convoluted tubing, conduit or other wire shielding is recommended to
minimize the likelihood of mechanical damage to wires.

Avoid routing wires near sharp edges or near locations that can cause the
wires to be “pinched” or damaged.

Use proper gauges and lengths of wire as shown in Table 1. Wire insulation
should be appropriate for engine applications.

Excessive length or inadequate gauge can cause increased wire resistance
that can limit the current to the actuator and prevent full actuator travel.

Increased electrical resistance can also result from poor wiring techniques. It is
important to use good quality terminations and proper crimping technigue
during wiring.

Terminations must be impervious to moisture to prevent shorts and corrosion.

Woodward
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APECS 500 Electronic Engine Controller

Wiring Length

Excessive resistance in the wiring will result in insufficient force from the actuator.
Such increased resistance can result from too much wire length, inadequate wire

gauge, or poor connections.

The following table shows the recommended gauges and maximum lengths of
connecting wires for different size APECS actuators. Wire length is the total length (to
and from) used to connect the actuator to the controller and the controller to the

system power.

NOTICE

All system wiring should be twisted pair and
shielded (preferably foil shielded).

Table 1. System Wiring

0175 66 ft (20 m) 33 ft (10 m) 22 ft (6.7 m)
0250 46 ft (14 m) 23 ft (7 m) 15 ft (4.6 m)
0300 46 ft (14 m) 23 ft (7 m) 15 ft (4.6 m)

(*) The controller has a working range of 9-30 Vdc. However, the actuator

must be selected for either 12 or 24 Vdc charging system.

Woodward
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Controller Installation

Controller Wiring

The controller can be installed in the engine compartment (maximum temperature
85° C (185° F).
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Figure 2. APECS 500 Dimensions

Table 2. Controller Wiring

Actuator Output ACT+ (Pin 3), ACT- (Pin 4)
Battery | VBAT (Pin 2), GND (Pin 1)
Speed Signal Input RPM+ (Pin 5), RPM- (Pin 6)
ACT Connector RCV (Pin 4), TXD (Pin 3), GND2 (Pin 1)
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Controller Pinout

Use the diagram below to connect your APECS controller to battery power, the mag pickup, actuator,
and ACT.

Calibration Tool Setup
Magnetic Pickup

RPM+ (Pin 5)

| Gomputer

RPM- (Pin 6)
Twisted Pair Shielded Wire @

- shield grounded at controller onl

| !—, RS-232 Cable ( 9 Y)
Eemale DB-9

Gnd (Pin 5)

TXD (Pin 2)

RCV (Pin3)

Twisted Pair Wire
(> 1twistperinch) o, (Pin 3 Proportional Actuator Output

ACT- (Pin 4)

Molex 39-01-2040

O Gnd (Pin 1)
XD (Pin 3)
RCV (Pin 4)
%‘ 3[1]
# s H[A 2]
1w 2 =1 Gnd
-] 2 Vbatt
gi! £ @ 3 ACT + \
§ (] - =i ACT - —
Bl s o

Speed Set —

Master Gain

APECS 500 Controller

Slow Blow Fuse
(10 amp)

Power (DC)
i T

VBAT (Pin 2)

GND (Pin 1)

Twisted Pair Wire
(> 1 twist per inch)

Figure 2. APECS 500 Wiring Diagram
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Speed Sensor Installation

Magnetic Pickup Wiring

Installed opposite an engine driven gear such as the flywheel, -
the mag pickup transmits a signal each time the magnetic flux U -

path across the pole is interrupted by a gear tooth. The [ ﬂHﬂMHﬂ!E’J*
mounting of the sensor unit must be rigid; excessive vibration

can cause erroneous signals and unreliable performance.

Connect the speed sensor to the two RPM inputs on the controllers. Most sensors
do not have a positive or negative side and can be connected either way. Use
twisted pair shielded wire for all speed sensor wiring. The shield should be
grounded at the controller only

RPM+ (Pin 5)
APECS 500
i TR

| RPM- (Pin 6)

Figure 4. Speed Sensor Wiring

Actuator & Linkage Installation

1. Select an actuator with sufficient force to move the fuel control lever from
minimum to maximum fuel position. Make certain that the actuator can reach
maximum fuel position when the actuator is warm, as some reduction in force
may occur. The controller has a working range of 9-30 VDC. However, the
actuator must be selected for either a 12 or 24 VDC charging system.

2. Select or design a bracket that correctly aligns the actuator shaft and control
lever and is able to withstand the vibration level of the engine or application.

3. The linkage must have minimal friction, binding and backlash. The bracket and
linkage should be designed to use as much of the actuator travel as possible.

4. Fasten actuator to bracket and bracket to engine. Attach necessary linkage
between actuator shaft and fuel control lever. Move linkage end-to-end to
confirm correct travel and adjust length if needed.

5. Connect actuator wires (use —————
twisted pair with more than 1 ARRSS S
twist per inch). Actuator travel il G S
should be adjusted to assure A
both maximum (start fuel or ACT- (Pin4) /
rated load) and minimum
(shutdown or idle) positions.

Figure 5. Actuator Wiring

It is beyond the scope of this manual to discuss

detailed actuator selection and installation
NOTICE procedures for all possible applications. Please
contact Woodward customer service for specific

information concerning your application.

Woodward 10
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Chapter 3.
Calibrating APECS Features

[ e
Calibration Guide

This section explains the procedures for calibrating (configuring and adjusting) the
various APECS 500 features to work with your application.

Before proceeding, make sure you have completed the installation of all the required
hardware for your system and are familiar with using the All-purpose Calibration Tool
(ACT). See Chapter 4 for details on ACT.

Engine speed and master gain can be calibrated manually without using the ACT by
adjusting the two potentiometers on the front of the APECS 500 controller.

Optimal performance is best achieved by using the ACT to individually adjust
Proportional, Integral and Derivative gains. More advanced features are also
accessible by

using the ACT.

If APECS 500 is to be used on a variety of engines or applications, it may be possible
to develop unique calibrations for each one, download before installation, and then do
any fine tuning using the manual adjustments.

Safety Precautions

The APECS 500 is a user configurable engine speed governor and will follow your
settings and commands immediately. Please be aware of this when calibrating and
entering values in the unit.

It is possible to enter values in the APECS unit that are in excess of what the
engine is capable of performing and outside of safe operating range.

It is the user’s responsibility to be accurate when entering data into the APECS or the
ACT. Entering values outside of safe operating range can result in serious physical
injury and/or damage to the equipment or application.

The engine, turbine, or other type of prime mover should be
equipped with an overspeed shutdown device to protect
against runaway or damage to the prime mover with
possible personal injury, loss of life, or property damage.
The overspeed shutdown device must be totally
independent of the prime mover control system. An

overtemperature or overpressure shutdown device may also
be needed for safety, as appropriate.

Woodward 11
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Manual Calibration
APECS 500 is equipped with two manually adjustable potentiometers:

e Set Speed Potentiometer: The user may manually adjust engine-operating
speed using the set speed potentiometer. This is a multi-turn potentiometer
requiring 20-30 turns to cover the full range of operating speeds. The
potentiometer has an internal clutch to prevent overturning. The range of
speeds commanded is adjustable using the ACT. Due to the resolution of the
internal digital electronics, it may not be possible to adjust operation to the
exact frequency (e.g. 60.1Hz vs 60 Hz).

e Master Gain Potentiometer: The user may manually adjust control gain using
the single-turn master gain potentiometer. Master gain influences Proportional,
Integral and Derivative gain. The range of gains commanded is adjustable
using the ACT.

Provided that the MPU frequency is compatible with the engine application, setup
consists of the following:

1. Set gain potentiometer to center of travel (5). The speed set potentiometer
should be set to the minimum speed (fully counterclockwise) position.

2. Apply power to controller. The status LED should turn on for one second,
indicating normal operation.

3. Crank engine. The status LED should turn on continuously indicating a good
speed signal from the MPU. If not, check the MPU installation and wiring. If LED
immediately begins to flash a two code (indicating engine overspeed), increase
the desired speed setting by turning the multi-turn speed set potentiometer
several turns clockwise. Repeat this crank and adjust process until the engine
starts.

4. Adjust speed setpoint until desired speed is achieved. If the engine speed will not
settle down, turn the gain potentiometer counterclockwise until stable
performance results.

5. Once the desired speed setpoint is achieved, adjust gain for optimal performance
at all loads. In general, this amounts to increasing the gain as much as possible
without inducing oscillation under any load.

6. If additional fine tuning is required, connect the ACT and adjust.

All-purpose Calibration Tool Set-up

To connect your PC to the APECS 500 use the cable provided with the calibration tool
kit. This cable has a DB-9 connector on one end and a four-pin white plastic Molex
connector on the other end.

Connect one end of the RS-232 cable to your PC’'s COM port. Connect the other end of
the cable to the control module.

The APECS unit must be powered up, but
NOTICE need not be mounted on the engine to carry
out the calibration procedure.

Woodward 12
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For further information on installation and operation of the All-purpose Calibration Tool
(ACT) refer to Chapter 4.

. N
Connector: Molex 39-01-2040
/ F’ M Terminals: Molex 39-00-0039
ﬁﬁ z HUJ
N
° Gnd
aeles o 5 Vbatt ACT Harness
3 #E D (9-30VDC)
) > S
§§ L) S
e
O' 3
COMPUTER
W
iy !
Female DB-9 |
g

Figure 6. ACT System Set-up

Calibration Categories

To incorporate any of the programmable features in your system, a set of parameters
associated with each feature must be calibrated using the calibration tool (ACT). These
parameters are grouped under various categories under the Calibrate Menu in ACT.
(Refer to Table 3 below.)

Table 3. Calibration Categories and Features

Governor Gain PID gain settings
Engine Set Speed Range of commanded speeds
Speed Input Speed input calibration
Engine Start Crank duty cycle
Diagnostics Overspeed/underspeed protection
Actuator Output Actuator offset

Calibrating an APECS Unit

Once the system set-up is complete it is fairly easy to calibrate an APECS 500
controller.

Before proceeding with calibration, please ensure that the controller unit is connected
to the COM port and powered.

Follow the steps below for calibrating your APECS controller unit.
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1. If anicon for the calibration tool exists, double click on it to start the ACT
software.

2. If noicon exists, click on the Start button, highlight “Programs,” find the ACT
software and click to start it.

3. Make sure the COM port designation in ACT matches the serial port on the
back of your PC.

Follow the procedure outlined in the Configure Menu to change the COM port
assignment, if needed.

4. The Wizard is an interactive guide to help you get your controller running as
quickly as possible. If you wish to use the Wizard for basic calibration, refer to
“APECS Calibration Wizard in Chapter 4.”

5. If you do not use the Wizard, calibrate the speed input for the type of speed
sensor, PULSES_PER_REV and PULSES_PER_UPDATE. “Refer to Speed
Input Configuration Parameters.”

6. Beyond basic calibration, there are many parameters associated with APECS
that can help enhance the performance of your engine. Read the section in this
chapter on “Understanding APECS Calibration Parameters” and decide on the
parameters you would like to adjust.

7. Access “Change APECS Calibration” option from the Calibrate Menu and
select the desired parameter from the appropriate category. Adjust the value of
the parameter as needed.

8. Repeat Step 4 until all desired parameters have been adjusted and satisfactory
engine performance has been achieved.

9. You do not need to save the new calibration settings. All settings are
automatically saved in the controller and remain in memory after shutdown.

Saving a Calibration Set to File

After satisfactory engine performance is achieved, it is recommended that you save the
calibration set to a file.

¢ A saved file allows you to experiment with other calibration settings and still be
able to recall the saved calibration set.

e A saved calibration set can be used for configuring additional APECS units.
To Save a Calibration Set to File:
1. Access the File Menu to activate the “Save APECS Cal to File” command.
2. Enter afile name to save the calibration data to a designated file.
3. When prompted to edit the comment list, enter information that will help you
keep track of specific engine, application and environment data associated with

the file.

4. ACT will save the calibration set and automatically append the file extension
“.ACT” to the file name.
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Calibrating an APECS Unit with a Saved Calibration File

You may wish to calibrate additional APECS units with a saved calibration file for
consistent, optimized operation.

To Calibrate an APECS Unit with a Saved Calibration File:

1. Access the Calibrate Menu to activate the “Download Cal File to APECS”
command.

2. Select the appropriate file to download (refer to the comment list on the right
side of the screen to help identify the desired file). Enter password if prompted.

3. ACT will download file calibration to APECS permanent memory.

4. Repeat Steps 1 and 2 if multiple APECS units are to be calibrated.

The APECS unit must be powered up, but
NOT’CE need not be mounted on the engine to carry
out the calibration procedure.
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Understanding APECS Calibration Parameters

This section provides answers to frequently asked questions about calibration
parameters, lists parameters, and provides calibration procedures.

Frequently Asked Questions

What is a calibration parameter?

A parameter is a numerical value that helps the calibrator adjust or set the APECS
controller. Once fixed by a calibrator, the parameter is not subject to change while the
system is operating. APECS calibration parameters are used not only to adjust and set
the controller but also to configure it properly for different applications.

Why do we need to calibrate the APECS system?

APECS 500 can be both manually and computer adjusted. APECS 500 is factory
programmed for operation between 2500 and 5000 Hz MPU frequency and with P,I,D
gains that should permit stable performance on the majority of applications. For optimal
performance, calibration with ACT may be required.

Do | need to calibrate ALL the parameters to make my system work?

No. All parameters are preset to values that will work with many engines and
applications. However, it is recommended that you review all settings for your own
application.

Is it possible to enter values in APECS in excess of what the application is
capable of performing?

Yes. While ACT (the calibration tool) restricts you from entering values outside of the
specified range, the range itself is fairly wide and it is possible to enter values in excess
of what your application is capable of performing.

For example, it is possible to command engine speeds up to 8192 RPM with ACT. Your
engine may or may not be able to operate at this speed. It is also possible to damage
the generator or pump attached to your engine by commanding maximum engine
speed because while the engine may be capable of performing at the rated RPM, the
generator or pump is likely to have a lower RPM rating than the engine.

Furthermore, there are certain parameters that are used to properly configure an
application. Entering incorrect values for these parameters will result in improper
configuration and may make the engine run at maximum throttle. Entering values
outside of safe operating range can result in serious physical injury and/or damage to
the equipment.
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List of Parameters

- DERIVATIVE_GAIN Speed stability 25
overnor
Gain INTEGRAL_GAIN Steady state speed 2
Calibration -
PROPORTIONAL_GAIN Transient response 2
RAMP_DOWN_RATE Engine speed ramp 1000
down rate
RAMP_UP_RATE Engine speed ramp up 1000
-~ rate
) Maximum engine speed
Engine Set SET_SPEED_MAX possible with speed pot 5000
Speed
Calibration SET_SPEED_MIN Minimum engine speed 2500
- - possible with speed pot
WARMUP_PCNT Engine warm up speed 0.8
WARM UP TIME Time spent at warm up 0
- = speed
PULSES_PER_REV :\(';/'0 fjt%“nlses per engine 60
Speed Input
Configuration ;
PULSES PER UPDATE No._of pulses until next 0
- - engine speed update
CRANK_DUTY_CYCLE Kickoff duty cycle for 0.945
Engine Start open-loop cranking
Calibration Percentage of set speed
CRANK_2 RUN_PCNT where crank-to-run 0.9
transition occurs
OVERSPEED PCNT Actuator shutdown 0
- speed (max)
OVERSPEED_TIME Time in msec before 250
setting overspeed fault
Diagnostics UNDERSPEED PCNT Actuator s_hutdown 0
Calibration - speed (min)
Time in msec before
UNDERSPEED_TIME setting underspeed fault 2500
speed (min)
UNDERSPEED_RUN_TIME Run time (sec) before 10
underspeed is checked
Actuator Initial value for duty
Output DUTYCYCLE_OFFSET cycle; adjust for 0.25
Calibration improved startup
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Governor Gain Calibration Parameters

PID Gains Adjustment

PROPORTIONAL_GAIN, INTEGRAL_GAIN and DERIVATIVE_GAIN are all multiplied
by the master gain from the single turn potentiometer. In effect, adjusting the master
gain adjusts all three. PROPORTIONAL_GAIN, INTEGRAL_GAIN and
DERIVATIVE_GAIN are preset to values which should permit stable performance on
most applications. To optimize performance, all three gains may be individually tuned
using ACT. It is suggested that the master gain potentiometer be set to the middle of
travel before adjusting gains using the ACT.

Calibration Parameters Requiring Configuration:

DERIVATIVE_GAIN
Engine speed governor derivative gain (unitless).

Derivative gain is used to improve stability. Increase derivative gain until response has
a slight overshoot on load transients.

INTEGRAL_GAIN
Engine speed governor integral gain (unitless).

Integral gain is used to remove steady-state errors. Increase integral gain until speed
begins to oscillate, and then decrease until oscillation stops. If oscillations do not occur,
bump actuator lever, then decrease integral gain until oscillation stops.

PROPORTIONAL_GAIN
Engine speed governor proportional gain (unitless).

Proportional gain is used to improve response time. A maximum amount of proportional
gain should be used while still maintaining stability. Increase proportional gain until
speed begins to oscillate, then decrease until oscillation stops. If oscillations do not
occur, bump actuator lever, then decrease proportional gain until oscillation stops.

PID Gain Settings Response Plots

ACT allows the user to adjust the P, |, and D gain settings and observe the response
directly on screen in the form of a real-time plot. The plots on the following page
illustrate the various conditions a user may encounter while tuning an application.
Although conditions may vary according to application and nature of load, these plots
are typical of what is often observed.

Figures 7-11 illustrate less desirable conditions often encountered while tuning an
application and suggest probable causes.

Figure 12 shows a plot of a properly tuned application. Although conditions may vary
according to application and nature of load, this plot is typical of what is often desired.
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Figure 7. PID Gains Too Low
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Actual RPM
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Figure 8. PID Gains Too High
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Figure 9. Integral Gains Too Low
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Figure 10. Derivative Gains Too High
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RPM

Desired RPM \
Actual RPM -)
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Figure 11. Integral Gains Too High or Derivative Gains Too Low

RPM

Remove Load

\__— Add Load

N

TIME

Figure 12. Desirable Response

NOTE: Excessive friction and slop in the
linkage are primary contributors to poor
governor stability. If it is not possible to
stabilize engine performance, check
smoothness of the linkage.
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Engine Set Speed Calibration Parameters
The following calibration parameters require configuration:

RAMP_DOWN_RATE
Rate at which command engine speed decreases from one set point to a
lower set point (RPM/second)

RAMP_UP_RATE
Rate at which commanded engine speed increases from one set point to a
higher set point (RPM/second)

SET_SPEED_MAX
Highest engine speed command possible with set speed potentiometer

SET_SPEED_MIN
Lowest engine speed command possible with set speed potentiometer

WARMUP_PCNT
Engine speed set point used immediately after engine has started running
(RPM)

WARMUP_TIME

Length of time to hold engine at warm up speed immediately after engine
has started running (seconds). Setting WARMUP_TIME to zero disables
the warm up feature.

Speed Input Configuration Parameters
The following calibration parameters require configuration:

PULSES_PER_UPDATE
The number of pulses received by the controller between engine speed calculations
and updates.

The fewer the pulses, the faster the update rate and the lower the resolution; the
greater the pulses, the greater the averaging effect on calculated engine speed.
Factory set to zero

Optimal performance is generally obtained by setting
PULSES_PER_UPDATE =2 * PULSES_PER_REV / (number of engine cylinders)

Setting PULSES PER_UPDATE = 0 will provide the fastest update rate, but may
detract from performance.

PULSES_PER_REV

The number of teeth on the engine speed pickup wheel (mag pickup input and Hall
Effect sensor), or the number of spark pulses per engine rev (ignition input).

To figure out the pulses per revolution, you must determine the kind of speed signal
input used on your application:

Magnetic Pickup Input or Hall Effect Sensor
Pulses per revolution = number of teeth on the flywheel

Woodward Mini-Gen™ Signal Generator
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Pulses per revolution = 0.5 x drive ratio if Mini-Gen is driven at
other than crankshaft speed

If readout is desired in Hz instead of RPM, set PULSES PER_REV = 60. This
may detract from performance. PULSES_PER_REYV is factory set to 60.

Engine Start Calibration Parameters

The engine cranking parameters control how APECS will drive the actuator during
cranking. The following calibration parameters require configuration:

CRANK_2 RUN_PCNT

Speed transition point indicating engine has gone from crank mode to run mode (RPM).
This transition is a percentage of the desired RPM commanded by the multi-turn
potentiometer.

Crank_2_Run RPM = Desired RPM * CRANK_2_RUN_PCNT

Once engine RPM rises above Crank_2_ Run RPM, it is assumed that the engine is in
run mode. Default value is 0.9

CRANK_DUTY_CYCLE
The fixed duty cycle used to drive the actuator when the engine is cranking (percent).

May be calibrated to a maximum duty cycle for diesel engines that require full rack for
starting, or a minimum duty cycle for some spark-ignition engines that require closed
throttle for starting. In run mode, control is closed-loop; the actuator is driven as
necessary to maintain the set desired speed.

NOTE: Default Value is 0.95, which will work with most engines and applications.
Entering new values for these parameters is optional.

Diagnostics Calibration Parameters

Overspeed / Underspeed Protection

The overspeed protection feature shuts off the actuator when the engine runs above
the overspeed RPM. Setting the OVERSPEED_PCNT value to zero disables this
feature.

The underspeed protection feature shuts off the actuator when the engine RPM runs
under the overspeed RPM. Set the UNDERSPEED_RUN_TIME value as desired.
Setting the UNDERSPEED_RPM value to zero disables the underspeed protection
feature.

When an engine overspeed / underspeed condition is detected, the engine protection
control logic causes: (1) the actuator duty cycle to go immediately to zero and (2) a
fault code activation that is signified by LED flashing. After engine protection control
logic tripping, the fault code will continue to flash the LED. This signifies to the user that
the engine stopped due to overspeed or underspeed engine conditions. The engine
may later be restarted without resetting the unit; this action will cause the fault code to
reset and the LED will then stop flashing.
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Calibration Parameters Requiring Configuration:

OVERSPEED_PCNT
Critical engine speed for overspeed protection (RPM). The overspeed setpoint will be
the current set speed plus the overspeed percentage.

Overspeed RPM = Desired RPM * (1 + OVERSPEED_PCNT)

Set OVERSPEED_PCNT to zero if overspeed protection is not desired. Normal closed-
loop governing will decrease the duty cycle to the actuator any time engine speed is
above the set point. Overspeed protection immediately shuts off the actuator when an
overspeed condition is detected. Engine speed must be brought back to zero before
the actuator is driven again. Setting OVERSPEED_PCNT to zero disables the overspeed
protection feature. Default value: 0.25.

OVERSPEED_TIME
Time, in msec, that an overspeed condition must exist before a fault is latched. Default
value: 250 msec.

UNDERSPEED_PCNT
Minimum engine speed used for underspeed shutdown. The underspeed setpoint will
be the current set speed times the underspeed percentage.

Underspeed RPM = Desired RPM * UNDERSPEED_PCNT

Normal closed-loop governing will increase the duty cycle to the actuator any time
engine speed is below the set point. Underspeed shutdown immediately shuts off the
actuator when an underspeed condition is detected. Engine speed must be brought
back to zero before the actuator is driven again. Setting UNDERSPEED_PCNT to zero
disables the underspeed protection feature.

UNDERSPEED_TIME
Time, in msec, that an underspeed condition must exist before a fault is latched.
Default value: 2500msec.

UNDERSPEED_RUN_TIME
Amount of time the engine must be in run mode before underspeed shut down is
activated (seconds).

How Does Overspeed Work?

The APECS 500 has the diagnostic capability to detect and react to an overspeed
condition. The feature uses two programmable parameters, OVERSPEED_PCNT and
OVERSPEED_TIME. Overspeed feature immediately shuts off the actuator when the
engine runs above OVERSPEED_PCNT for OVERSPEED_TIME.

OVERSPEED_TIME is used to adjust the sensitivity. A large value will delay the shut
down, and a small value will hasten it. A value as small as zero can be used, which
means that the first occurrence of engine speed being over OVERSPEED_PCNT will
result in a shut down. This is too sensitive and the engine could be shut down in the
unlikely event that noise on the speed signal input caused a high miscalculation of
engine speed. A minimum value of 250 msec is recommended. The user should
realistically determine an overspeed tolerance time.

When an overspeed condition is detected, the duty cycle goes immediately to zero.
This should stop the engine or at least drive it to minimum speed. A fault code is
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generated, and the LED flashes. The fault will continue to flash so that the user is made
aware of why the engine stopped. The engine may be restarted without resetting the
unit. The fault will then recover and stop flashing.

By default, overspeed is disabled. This is because a properly tuned PID governor will
decrease the duty cycle to the actuator any time engine speed is above the set point.
So ordinarily, overspeed is not necessary. It is disabled by setting OVERSPEED_PCNT
to zero. However, if a user feels the need for a more aggressive response to an
overspeed condition, the overspeed diagnostic feature may be used.

Actuator Output Calibration Parameters
The following calibration parameter requires configuration:

DUTYCYCLE_OFFSET

The total PWM duty cycle output to the actuator is the sum of the Proportional, Integral
and Derivative branches plus an offset term, DUTYCYCLE_OFFSET. The integrator is
always reset to zero at startup. Setting DUTYCYCLE_OFFSET to a non-zero value
helps the transition from crank to run modes. Default value is 0.3
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Calibration Setup & Configuration Parameters Flowchart

Step 1

Setup the APECS
Calibration Tool
(ACT)

Step 2

»| Configure speed input:

PULSES_PER_REV
PULSES_PER_UPDATE

Computer

Step 3

Calibrate the range of

commanded engine speed.
SET_SPEED_MIN
SET_SPEED_MAX

The APECS 500 is a user configurable engine speed governor and will follow your
settings and commands immediately. It is possible to enter values in the APECS
module that are in excess of what the engine is capable of performing and outside of
safe operating range. It is the user's responsibility to pay attention when entering
data into the APECS or the ACT. Entering values outside of safe operating range
can result in serious physical injury and/or damage to the equipment or application.
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Step 4

features by configuring
the listed parameters

A
Engine Cranking Default

CRANK_DUTY_CYCLE  0.95
CRANK_2_RUN_PCNT  0.90

Calibrate the selected »

Step 5
Calibrate any additional
parameters , if needed.

Step 6
Adjust PID Gains
» DERIVATIVE_GAIN

Overspeed/Underspeed Protection

OVERSPEED_‘PCNT
UNDERSPEED_PCNT
UNDERSPEED_RUN_TIME

l

RAMP_DOWN_RATE
RAMP_UP_RATE
WARMUP_PCNT
WARMUP_TIME

PID Gains too high

Desred RPM \

.

™E

PID Gains too low

P—
N

o

INTEGRAL_GAIN
PROPORTIONAL_GAIN

seat e J

Integral gain too high
or derivative gain too
low

Achusl REM

i ANANANANANANANA

Desrad RPN

TME

Derivative gain too
high

N\ Lo

THE

Integral gain too low

TiME

Desired response
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Chapter 4.

ACT Operation
|

ACT Installation
ACT Kit Contents

The All-purpose Calibration Tool (ACT) is used for programming (configuring and
adjusting) and monitoring the APECS controller with your personal computer. The ACT
kit contains the following:

e Software CD-ROM

e Interface module

e RS-232 connecting cable

e CD-ROM Installation Guide

Set-up Requirements
Hardware Requirements

e IBM compatible personal computer equipped with a CD-ROM drive and a serial
port with DB-9 connector, capable of 9600 baud communication

e Windows software: 95/98/Me/2000/XP

e 64 MB of available RAM memory and a hard disk with at least 2.0 megabyte of
free disk space

e SVGA capable video card and monitor, capable of 256 colors and 800 x 600
display

Software Requirements

CD-ROM of calibration tool software to run on your personal computer.
(CD supplied with ACT kit.)

Hardware Set-up

To connect your PC to the APECS 500 use the cable provided with the calibration tool
kit. This cable has a DB-9 connector on one end and a four-pin white plastic Molex
connector on the other end.

Connect one end of the RS-232 cable to your PC’'s COM port. Connect the other end of
the cable to the control module.

NO T’CE ;rohreAACF')I'Et%S:)ig?artnel:ISt be powered up in order
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m
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Figure 13. ACT System Set-Up

Software Set-Up

ACT software can be automatically installed on your hard drive from the CD-ROM
supplied with the kit. To install the software, follow the procedures below.

Close all applications to prevent possible
NO T’CE conflict between the ACT installer and other
programs.

Turn on your computer and insert the ACT disk into the CD-ROM drive. The
install program should automatically launch. If it does not, open Windows
Explorer, go to the CD-ROM drive and double click on the install program.

Follow the prompts from the install program. You may select the default
directory or specify your own.

When installation is complete, you may access the ACT software from the Start
Menu or create your own shortcut.

The set-up is now complete and you are ready to run ACT.

e Torun the ACT software, please refer to “Running the ACT Software”
in the following section.

e Put the original CD-ROM in a safe place in case the files on your hard
drive become damaged or lost.

Woodward
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Basic ACT Operation
Running the ACT Software

The ACT software is fairly easy to use. Follow the procedures below to run the
program.

Ix

9. Make certain that the APECS Lizama e
controller is powered up and

s Coppright [C] 2004 “Woodward, Inc.
connected to the computer's COM "
port e e e T PO A
' regaldlessdl?ﬂolm&mﬂa.v}ilhﬂutnﬁm i
H . . wiithen consent of Woodward, Inc,
10. If an icon for the calibration tool T
exists, double click on it to start Eere il o
the ACT software. The license by s f gy, oo sl
screen will be displayed when the o e el g
ACT is launched. You must either
accept the terms or Cancel, which [Tt
exits the application. G|

11. If no icon exists, click on the Start button, highlight “Programs,” find the ACT
software and click to start it. Default is Woodward, then select “APECS-EPS
Calibration Tool.”

12. Make sure the COM port designation in ACT matches the serial port on the
back of your PC.

13. Follow the procedure outlined in the Configure Menu to change the COM port
assignment, if needed.

Progress Display Screen

This screen is intended to inform the user of the progress of time-consuming
communication procedures. It will close automatically when the procedure is complete.

Pitasis o'y Tl slon Valkoit

EE_FAULTE 1
(R

Moving Around the Software

There are five main menu items available with ACT. Several options are available
under each main menu item. The discussion in the following pages assumes the cursor
is at the main menu screen.

e Use mouse to select or move around the menu.
o Use left mouse to execute a command or accept a condition.
e Use function key <F1> for HELP.

e A HOT key (highlighted character in a menu item) can also be used to access
or activate a menu or sub-menu, e.g. File use <ALT> <F>.

e Click on the x| box in the upper right hand corner to exit ACT.

Woodward 29



Manual 36513 APECS 500 Electronic Engine Controller
ACT Menus & Options

ACT Menu Structure

ACT'’s five main menus—File Menu, Calibrate Menu, Monitor Menu, Configure Menu,
and Help Menu have several options available under each. A complete discussion of all
ACT menus and options is presented in the following pages.

Save APECS Cal to File

View Cal File Comments

View Text File

FILE MENU
Convert APECS Cal to Text

Convert Cal File to Text

Convert Cal File to Strategy

Change APECS Calibration
Download Cal File to APECS

CALIBRATE MENU Compare APECS Cal to File Cal
Change APECS Password
APECS Calibration Wizard

Parameter View

Parameter Plot

MONITOR MENU Display Faults
Control Strategy

Parameter List

CONFIGURE MENU Configure Serial Port
Help Topics
HELP MENU About ACT

User Manuals

File Menu
Purpose

The File Menu allows you to perform operations related to viewing, saving and
converting files. The following commands are available under the File Menu.

Save APECS Cal to File
View Cal File Comments
View Text File

Convert APECS Cal to Text
Convert Cal File to Text
Convert Cal File to Strategy
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Save APECS Cal to File

This command allows you to save APECS calibration data to a designated file. The
ACT uploads the calibration set from the APECS controller and saves it to a computer
file. This operation is usually done after the controller has been calibrated for
satisfactory engine performance but can also be done at any other time. The data is
saved in a binary file format that is not readable.

To Save APECS Cal to File:
14. Choose File > Save APECS Cal to File.

ACT will prompt the path where the file will be saved:

2x]
15. Enter a file name to save the s [T HeasE
calibration data to.
ACT will automatically append the
file extension .ACT to the file name
if you do not specify one. Click
Save or press <Enter>. File name: [y Cal Fi Save |
Save as bype: |CAL Files [*ACT) =l ﬂl/
A

ACT will then read all of aunLe
the current calibration
values from the controller.
This screen shows the

Processing Calibration Values

PROPORTIONAL_GAIN

progress.
|
Al E Once all the values are read, ACT will

9 prompt you to add comments to the ACT
\_..q/ Do you wish bo edit the new Cal File Comments? file to aid in later identification.

16. If you click Yes, the comment editor
screen will appear.

To enter comments, type them one at
a time and press <Enter> or click Save
Edit. You can re-edit comments by
clicking them, changing the text on the
top line and clicking Save Edit.
Comments can be deleted by clicking
on them and then clicking “Delete” or bee | | pdipetion| | Swetd | | ComoEa |

by pressing <Del>. e | o |
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17. Click OK on the comment editor or press <Enter> twice to save comments.
Click Cancel or press <Esc> twice to close the window without saving
comments. The Cal File will still be created if the comment editor is canceled.

18. The following message is displayed when the file is created successfully.

@ Cioodward\ACT ToolhCal kool skuff 1,ACT Created Successiully

The file name in this message is the file selected in Step 2. ACT will save the
calibration data to the designated file and display “Calibration Data Saved in
File: ABCD.ACT” message (where ABCD is the name you entered in Step 2).

NOTICE

The “Save APECS Cal to File” command stores
the calibration data as an .ACT file that
cannot be viewed or printed directly. Viewing
and printing must be done from a converted
text file. See Convert APECS Cal to Text and
Convert Cal File to Text commands.

View Cal File Comments

This command allows you to display the comments that are attached to a calibration
file. Users add comments when saving a calibration file. The comments help in
tracking specific engine, application, and environment data for which the calibration
file was created.

To View Calibration Comments:

Select a Calibration file and its comments ai

Loak in: I m Deskiop

2]x]
x| + & et E-

1. Choose File > View Cal File

Comments.

ACT will display a list of files on the
left side of the screen with file
comments on the right:

Use the Up and Down arrow keys to
highlight the desired calibration file
(.\ACT extension) and view the

My Dacuments

2= My Computer

(EE My Metwork Places
o2 CAD System Files
] DEMO. 000

[ | EF Pof's

File name: I

j Clase

Files of type: ICaI Files(* 000:% ACT]

™ Open as 1ead-only

Calibration File Commets:

comments attached to that file.

3. Click OK or Cancel to close Comment
Viewer. The comments are created or
edited when the files are created. 4

View Text File
This command is a convenient way to view text files.

1. Choose File > View Text File.
2. ACT will prompt for a text file to view.
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3. Select a file and click OK.
4. ACT will open the selected file with the default viewer for that file type.

Convert Commands

The “Save APECS Cal to File” command, discussed earlier, stores the calibration
data as an .ACT file that cannot be viewed or printed directly. Viewing and printing
must be done from a converted text file.

There are two convert commands available with ACT: “Convert APECS Cal to
Text” and “Convert Cal File to Text.” The difference between the two commands is
as follows:

1. In*“Convert APECS Cal to Text” operation, the calibration set that is converted
is from the APECS unit.

2. In“Convert Cal File to Text” operation, the calibration set that is converted is
from a previously saved file.

You may use the View Text File command to view text files.

Convert APECS Cal to Text

This command allows you to create a text file of APECS calibration data for viewing or
printing from any text editor utility in Windows. A printed copy of the calibration data
can be useful for future reference.

To Convert APECS Calibration to Text:
1. Choose File > Convert APECS Cal to Text.

2. ACT will prompt you to enter a name to save the text file. Enter a file and click OK.

ACT will read all of the calibration values from the controller, create and save
a text file with the parameter names, values, and units, then display the file
using the default text viewer.

Convert Cal File to Text

This command allows you to convert a previously saved .ACT calibration file to a text
file for viewing or printing from any text editor utility in Windows. A printed copy of the
calibration data can be useful for future reference.

To Convert Cal File to Text:

1. Choose File > Convert Cal File to Text.
2. ACT will prompt you to enter a name to save the text file. Enter a file and click OK.

ACT will read all of the calibration values from the controller, create and save a
text file with the parameter names, values, and units, then display the file using
the default text viewer.

Convert Cal File to Strategy

This command is used to convert old ACT files for use with controllers that have a
different control strategy version.

ACT will:
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1. Parse through all of the calibration parameters in the old ACT file.

2. Search for the same calibration parameters in the new ACT file and assign
values from the old calibration.

To Convert a Cal File to a New Strategy:

1. Choose File > Convert Cal File to Strategy.

2. ACT will prompt you to enter a name to save the text file. Enter a file and click
OK.

ACT will read all of the calibration values from the controller create and save a
text file with the parameter names, values, and units, then display the file using
the default text viewer.

Calibrate Menu

The Calibrate Menu allows you to perform operations related to APECS calibration.
The following commands are available:

e Change APECS Calibration*

e Download Cal File to APECS*

e Compare APECS Cal to File Cal
e Change APECS Password*

e APECS Calibration Wizard*

(*) These commands can be password protected to prevent unauthorized calibration
changes. See “Change APECS Password” for more information.

Change APECS Calibration

The “Change APECS Calibration” command allows you to calibrate (configure and
adjust) various parameters associated with the APECS controller.

APECS 500 is a programmable engine governor. Changing APECS calibration
parameters is the means to configure the APECS controller for specific engines,
applications and environments, and for adjusting PID gains.

The calibration parameters have been organized into categories for your convenience.
Browse through the categories to view the specific parameter you want to change or
adjust.

Some parameters must be set before the engine can run. Other parameters can be
adjusted while the engine is running. A complete list of parameters appears in
“Understanding APECS Calibration” in Chapter 3.
All adjustments are stored immediately in non-volatile memory in the APECS unit.
The APECS controller will retain the changes even if power is lost or the ACT is
disconnected.
To Change APECS Calibration Parameters:

1. Choose Calibrate > Change APECS Calibration.

2. Setthe “View Filter” to select a group of parameters.

3. Use F5/F6 to scroll through the list.
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4. To change the highlighted parameter:
Enter the new value in the “New Value” field

Press <Enter>

The new value is written to the controller and then read back, with
the result placed in the “APECS Value” field.

5. Press <Esc> to exit.

Download Cal File to APECS

The “Download Cal File to APECS” command allows you to download the entire
calibration set from a file to the APECS permanent memory. This is a convenient one-
step method for:

¢ Reverting back to a known good calibration set after experimenting
with new calibration settings

e Programming multiple APECS units for a particular application

The downloaded file may have been previously configured and calibrated for
satisfactory engine performance with another APECS unit.

To Download a Cal File to APECS:

- i
1. Choose Calibrate > e 2

. Look . | (4] Desktop B F=i="
Download Cal Flle to APECS [y Documents
The following screen allows

you to select a Cal file to 40 Sy Fies

download. EF PaFs
File name: [ Open |
Files of type: [ Cal Files(.000:" ACT) = Cancel

™ Open as jead-only

Calibration File Comments:

2. Choose a file and click OK. The following screen will show the progress.

Processing Calibration ' alues

OVERSFPEED_RPM

I
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3. The following screen is shown when the operation is complete.

ACT x|

L] E The calibration file was downloaded successfully.
[ ]

During the “Download Cal File to APECS”

operation, the user may encounter a situation

NO T’CE where the Cal File password is different from
that of the APECS unit. If this happens,
please refer to the steps below to complete
the download operation.

To Download a Cal File to APECS with a Password Different from that of the
APECS Unit:

Whenever the APECS password is added or changed, the new password is stored in
the unit as well as in any calibration file saved after the change.

During a “Download Cal File to APECS” operation, if the password stored in the
calibration file matches the password in the unit, ACT will readily download the
calibration to the APECS unit.

However, if the password stored in the calibration file does not match the password in
the APECS unit, ACT will alert you of a password mismatch. Please follow the steps
below to complete the download operation.

1. When a password mismatch is detected, the ACT displays a message “Cal File
password differs from that of the APECS unit. Download the Cal File password
to the APECS unit?”

2. If you answer Yes to this message (see note below), the calibration file will be
downloaded and the password in the APECS unit will be changed to match the
password stored in the calibration file.

3. If you answer No to this message, the calibration file will still be downloaded
but the password in the unit will remain unchanged.

Before answering Yes to the message, make

sure you know the password in the

NOT’CE calibration file. If you do not know the
password, you will not be able to access the
password protected features under the
Calibrate menu.

Please see “Change APECS Password” command for more information on password
protection.
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Compare APECS Cal to File Cal

This command lets you check the differences in calibration sets between a saved file
and the APECS unit. The feature is useful, for example, to ensure that the saved file
matches the calibration in the APECS unit.

To Compare APECS Cal to File Cal:

1. Choose File > Compare APECS Cal
to File Cal. This screen allows you to

select a Cal File to compare.

2. Choose afile and Click OK.
This screen will show the
progress.

Once all parameters have been processed, a

Choose a Calibration file ko compare: E

21x

Lack jn: | ] Desktop

B W=

“My Documents

= My Computer

(52 My Network Places
|22 CAD System Files

Fie pame: ]

Open I

Files of type: IEa\ Files[* 000, ACT)

™ Dpen as 1zad-orly

Calibration File Commerts:

LI Cancel

Pracessing Calibration Yalues

OYERSPEED_RPM

I

ACT

message box will list the compare results. If the

parameters in the file match the controller, the

& File Matches Controller

following message box appears:

Click OK to close. If there were mismatches, the following message will
appear:

Compare Differences %]

Controller <> C:oWOODWARD-ACT TOOLMNAPX41MOSTEST ACT Mismatch List
ame File Controller T[nits
ACTUATOR_FDEK_GATH 0.20001 072498 HONE
ACT_FDBK_KFILT 0.801 0.977 NONE
AFE_LOST_DLY 21 20 ns*1D
AFE_NO_AMPS 33000 0 nd

AFP_AD ORH 25 1023 adcnts
AFF_AT_ORL 10 0 adonts
APP_FULL_DEADBAND 3 S adcnts
APE_IDLE DEADBAND 5 adcats
APP_MIN_CAL 230.0 240 5 adents
APP_NOISE CHT 31 30 HONE
APP_RANGE_CAL 550.0 540 5 adcnts
AUTOCRANK_CRANK_TIKE 11.0 10.0 s=c
AUTOCRANK MAY TRIES 5 & HONE
AUTOCEANK_NS_TIHE 1.0 15 e
AUTOCRANK_REST_TIME 16.0 A6 0 Be
AUXILIARY OUTEUT 2 KODE 1 0 HONE
AUZILIARY OUTEUT_KODE 2 0 HONE

AUX T _LIH 121 120 azd
AUX_LAMP_INRUSH_TIHE 4 3 msec=10
ATI_OUTEOT_2_FI 1500.0 700.0 rpn
AUL_OUTEUT_REI 1501.0 700.0 rom

BRAKE DELA’ 1.0 0.0 sec
CRANK_2_RUN 1100.0 700.0 rpn
CRANK_DUTY_CYCLE 1.000 0.945 %-100
DERIVATIVE GAIN 0.262 0.250 HONE
DERIVATIVE GAIN_IDLE 0.262 0.250 HONE

] »F‘

Oose  |[07”

LRI
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You may select "Save to File" if you would like to save a permanent record of
the file compare. You will then be asked to select a destination directory and

file name.

Change APECS Password

This command allows you to add or change a password to protect certain calibration
features. The option is useful, for example, to prevent unauthorized changes to a
known good calibration set in the APECS unit.

By default, the APECS unit is not password protected.

To Change APECS Password:

x
1. Choose Calibrate > Change APECS
Password. You will be prompted for the
current passwo rd. Flease enter the controller password: I"*’1
— Change | Cancel | QK. I
IEnter pazgword and click DK,
2. The application will zn
query the controller to
verify that the entered
password matches the Pleaze enter the contraller passwold:l
current password. If the
password matches, the
“Change” button is
enabled: S Change | Cancel | QK. I
IPassword Walid. Click 'Change' to change contraller passward
3. Click “Change” and the application will prompt for the new password:

Password Managemenk

Enter new Password: I

x|

Cancel | oK |

Change I
Status:

FPazzword Change Mode.

4. Enter the new password. It should be one word, no spaces, and up to 11
characters long. Once entered, click OK. The application will prompt to
re-enter the password to make sure that it was typed in properly:
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5. Re-enter the password and click x|

OK. If the two entries of the new

password are equal, the new

password will be encoded and Re-enter new password: |I
saved in the controller.

Passwords are upper and lower case Change |  Cancel | ok |

. Status:
sensitive. IPassword Change kMode.

After changing your password, please record it in a safe place for future reference. To
revert to no password protection, change APECS password to “peg,” which is the
default password.

ACT Operation with the New Password:

Once a password is added or changed, the following calibration features become
password protected:

Change APECS Calibration
Download Cal File to APECS
Change APECS Password
APECS Calibration Wizard

At the start of any future sessions, ACT will always prompt you to enter the new
password to gain access to these features. You only need to enter the password once
during any session to gain access to all the password protected features.

APECS Calibration Wizard

The APECS Calibration Wizard is an interactive guide to help you get your controller
unit up and running as quickly as possible.

To Calibrate a Controller Unit Using the APECS Calibration Wizard:

Choose Calibrate = Calibration Wizard.

2. The Wizard will give you the option to use the default calibration or modify the
existing one. If you select the default calibration, the Wizard will reset all
calibration parameters.

3. Press <Enter> to continue or <Esc> to abort the Wizard.

If you press <Enter> the Wizard will lead you through the calibration
process with a series of questions. When all questions have been
answered the Wizard will ask you to confirm that the values entered
are accurate.

4. Press <Enter> to confirm the values, <PgUp> to go back and change the
values, or <Esc> to abort the Wizard.

If you press <Enter>, the APECS Wizard will download the new calibration and
reset all APECS parameters. This will complete the APECS Wizard operation.
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The APECS Calibration Wizard only covers basic

calibration. It does not automatically assure
NOTICE optimum engine operation. Please refer to APECS
Calibration Procedures for more information.

5. You are now ready to run your engine. Press any key to go directly to the
Parameter Plot screen where you can adjust the PID gains.

Monitor Menu

The Monitor Menu allows you to observe engine and APECS operation in real time.
The following commands are available under the Monitor Menu.

e Parameter View
e Parameter Plot
o Display Faults

e Control Strategy
e Parameter List

Parameter View

This command allows you to view certain operating variables (i.e., engine speed) inreal
time.

To View Parameter Values in Real Time:

1. Choose Monitor > Parameter

View. The application will launch S Paranci SR =1
the view screen. Hame I Velue [ Uris |
Eenging_rpm 399.4  pm
n_desired 25606 pm
Stop tpo_dutycycle 003439 MONE
| app_nom 043771 MONE
2. The screen automatically starts _ Coniiue|

reading values from the controller
and displaying the values.

3. To stop the updating, click on
Stop. The button name will then
change to ‘Start.” Clicking it again
will start updating again.

If any other screen is opened that requires
NO T’CE communication with the controller while the
screen is updating, the Parameter View screen

will be automatically stopped.
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Parameter Plot

The Parameter Plot command lets you view engine performance on screen in the form
of a real-time graph. This feature allows you to perturb the system and observe the
response to fine tune engine performance.

To View Parameter Plot in Real Time:

Select Monitor - Parameter Plot. The application will launch and start the parameter
plot view.

[ Parameter Plot

The application will read the
previously saved configuration
and request the controller to
start sending the parameter
values. The controller sends
the data to the PC at a rate that
varies with the number of
parameters being monitored.
The application uses the
Windows timer functionality to
update the screen at the
specified rate. Note that if the
PC is very busy, the timer
accuracy will vary; therefore,
the screen and generated data
files should be considered as
reference only.

engine_rpm [rpm] 1576.142
{ Tonfigue engine_speed [1pm] 1525000
Save to File |

The X-axis time scale (25 seconds in the example screen) may be shorter than
configured due to the resolution of the monitor. This value will be adjusted when the
graph is resized. This also applies to the print functionality for this screen. All of the
data will be recorded in a revolving buffer for use by the “Save to File” feature (see
below).

The axis scales, parameter names, update resolution and time scale on the Parameter
Plot may be changed as described in the Plot Setup screen.

PID Gain Adjustments from Plot Display Screen

After initial calibration, most engines require only a minor adjustment to PID gains to
fine tune the system to its optimum level. ACT provides a convenient means of
adjusting the PID gains directly from the Plot Display screen.

To Make PID Gain Adjustments from Plot Display Screen:

1. Press the letter <P> for proportional, <I> for integral, or <D> for
derivative gain adjustment. The application will enable the gain you
selected.

2. Use the Up or Down arrow keys to increase or decrease the present
value. The arrow keys adjust the values by 0.004. New values may be
typed in directly. Hit <Enter> after you type in a value. The application
will save the new value in the APECS unit.

3. Press <Esc> to deselect the gain adjustments.
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This allows you to choose engine RPM, desired engine speed, duty cycle or any other
parameter for viewing real-time plots on screen. Axis scales can also be adjusted to fit
the parameter and/or speed.

19. On the Parameter Plot screen, click on “Configure.” The application will show
the following screen with the current values.

Xl
Flat 2
ﬂ Iengine_speed j
Az Max |1 800 Az Max |19|JIJ
Aiz Min I1 500 Axis Min I1400
% fwiiz Time Scale |20 [sec) MNumber Vertical Divisions |11 -
# Mwiz Sample Bate | 250 [m-zec) Murber Horizontal Divisions |1 1 - l
Open | Save | Cancel | ak I
Plot 1/ Plot 2

Use the pull-down to select the desired parameter to plot.

Axis Min / Max
Enter the minimum / maximum value for the parameter value.

X Axis Time Scale
Controls how much data is displayed on the X axis. This value may
automatically adjust for screen resolution.

X Axis Sample Rate
Controls how often the data from the controller is used to update the
screen. Data received between timer ticks is discarded.

2. Clicking OK will save this information in the Windows Registry so
that it will be remembered the next time the program is started.

NOTE: The Calibration Wizard will automatically set up the plots if
there are no saved defaults.

Display Faults

i Diagnostic View E

eI

This command allows you to display

[~ Current Faults:
present faults in real-time. This o [ T
means if new faults occur while you ||| St ] s S
are monitoring, the screen wil i
automatically update to display the et s
current faults. The display will also
show historical fault codes that have Uy o o (S| Rt o Do
been previously logged but do not
currently exist. Historical fault codes
are helpful when tracking down
intermittent faults.
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To Display Faults in Real Time:

1. Choose Monitor - Display Faults from the main menu. The application will
launch the Fault view.

The application will update the display every time the controller sends the
fault_flags status. This happens several times a second.

2. Click on the “Pause” button to stop the automatic update of this screen. The

text on the button will change to “Start” and clicking it again will re-start the
automatic updating.

If any other screen requests data from the
NOTICE controller while this screen is updating, this
screen will automatically Pause.

Control Strategy

This command allows you to check the version of the control strategy in use. This
information may be needed for strategy identification purposes and for future updates.
Parameter List

The Parameter List screen allows the user to adjust which parameters are displayed on
the Parameter View display.

To Display the Parameter List:

1. Choose Monitor > Parameter List from the main menu.

2. The F5/F6 keys will B g [
backup/advance through ol

the list. Press F9 or click on  rocme L
“On View List” to toggle the I~ OnvenLis
selected parameter on the & b (|
Parameter View screen. o
Pt
3. Click on the ) box in the o

title bar or press <Esc> to :
close the screen. Edits are fal s

not saved between g

. . lamp_timer - -
application launches. T

|[F5]F’F(EV|UUS [FEJNERT  [FS]ADD/REMOVE ONVIEW  [ESC]CANCEL EDIT /CLOSE
il | AW
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4. If the Parameter View screen is already open when changes are made to
the view list, close the Parameter View screen and re-open it to make the
changes effective.

Save
Clicking Save will prompt the user to
Choose or create a file to save the vizw d | save the CUrrentIy Viewed
Savein | 0 ACT ] - (e e [ configuration to a file. Type in a file
=] engine spesds.avf name that reflects the purpose of the
[ error coces.af saved configuration and click Save.

The view configuration dialog will
now display the selected file name in

the title bar.
Open
e = Cllckmg Open will prompt the user
for a file name of a previously saved
Save az type: IAET Wiew Setup Files [*.avf) j Cancel |/ V|eW Configuration_
A

Select the desired file and click Open. The View Configuration will be updated with the
saved parameters.

The ACT application will always recall the default set of plot configuration parameters
at application startup, and does not recall the last used view setup file. So the view
configuration will always start with the default view.

Several parameter view screens can be open with different configurations by changing

the configuration on the parameter list screen (F9 or Open), then opening a new
Parameter View.

NO T’CE Only one of the parameter view screens can be
monitoring the controller at once.

Configure Menu

Configure Serial Port

This command allows you to designate the proper COM port for your PC to enable
communication between the ACT and the APECS controller.

To Configure the Serial Port:

1. From the main menu screen,

choose Configure - Custom ACT Communications Configuration x|
S_erlal Port' The a_ppllcatlon WI” — Serial Controller Connection— — Demo Mode
display the following screen: £ com1 % S Corcel_|
. " Com2 O
2. Choose a port and click OK. Cowen [ || C apECs a0

This screen will be displayed on
application startup if a controller
cannot be found at the last
selected port and can be
changed any time after the
application has started.

" APECS 4000

" APECS 4500
" APECS 5000
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Demo Mode

This mode will use a calibration file “Demo.000” and use random numbers
for values requested from the controller.

COM1/COM 2

This mode will look for a controller attached to the selected serial port. An
error message will be displayed AFTER you click OK if a controller cannot
be found or if the port cannot be opened.

COM ports outside of this range can be used by editing the default COM
port registry key for this application.

Help Menu
The Help Menu provides access to the online user’'s manual and other information helpful to
your use of the calibration tool. The following commands are available under the Help Menu:
e Help Topics
e About ACT
¢ User’'s Manual

Help Topics

This command allows you to search for specific information by displaying software menu
items or through key words.

20. Click on “Contents” for an outline of the software applications listed by menu
items.

21. Click on “Index” or “Find” to locate a specific topic through an alphabetical
listing or by typing in a word or phrase.

22. Follow the on-screen commands to page through the manual.

About ACT

This command displays the version of the calibration tool that you are currently using. This
information is important for tool identification purposes and for servicing support.

User’s Manual

This command accesses the User's Manual, which includes comprehensive information on
the APECS 500 controller, wiring diagrams, ACT software menus, and calibration
parameters. The manual may be viewed online or printed for future reference.
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Chapter 5.

Troubleshooting
|

General Checklist

Please follow the checklist below to troubleshoot your APECS controller.

We recommend using a digital multimeter capable of measuring frequency and duty
cycle such as a Fluke 87.

1.

Check battery voltage for stability and correct value. The LED will turn on for
one second when the APECS 500 is first powered up.

For magnetic pickups, check that the speed signal is at least 2 Vs using the
AC volt settings on voltmeter. Actuator should go to full travel during cranking.
The LED will illuminate when it senses an engine speed.

Check the actuator linkage for binding and backlash.

Check that the actuator has sufficient force to reach the starting and rated load
positions.

Confirm normal operation of engine under manual control.

Confirm that the load (e.g., voltage regulator on generator) is not inducing
instability.

Try adjusting the gains to achieve stability.

Fault Codes

The APECS 500 controller is capable of identifying certain fault conditions and
alerting the user to them. A flashing LED indicates the fault conditions. The current
fault code list is shown in Table 6. Please note the following:

1.

When power is first applied to the controller, the LED will flash just once for one
second to indicate that the LED is working.

If there are multiple faults, the LED will flash them all in sequence. Count the
flash codes to determine the fault conditions or connect the calibration tool to
observe the fault conditions. (Use the “Display Faults” option under the Monitor
Menu.)

If there are no faults, the LED will flash once at reset and from then on indicate
the detection of engine speed. A continuous ON LED indicates that a valid
engine speed is being sensed.

The controller will attempt to shut down for some faults and will not permit
starting after reset with faults 1, 5 and 8.
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Table 6. Fault Codes

FLASH ENGINE
CODE FAULT SHUTDOWN CORRECTIVE ACTION
APECS unit not .
1 calibrated Yes Calibrate PULSES_PER_REV.
Check parameter settings. Overspeed criteria may
be too sensitive.
Check for electrical noise entering controller.
2 Engine speed Yes Check wiring and connections.
excessive
Check case ground.
Make sure linkage moves freely, without backlash.
Check tip of speed sensor.
Check parameter settings.
3 Engine speed ves Check linkage and the actuator travel.
unusually low Ensure that load is not greater than engine
capacity.
Actuator
4 disonnected, Yes Check actuator wiring and actuator resistance.
open circuit or Resistance should be less than 10 ohms.
short circuit
If calibration file is available, download calibration
5 Factory v file and cycle power again.
; es
settings lost If controller still does not work or if no calibration
file is available, consult factory.
Defaults to
6 Speed set pot minimum Consult factory.
out-of-range
speed
7 Gain set pot out Yes Consult factory.
of range
Electrical noise may be entering controller.
) Check wiring, shielding and connections to
8 Contfrq:le(jr unit Yes controller.
aile .
Cycle power to engine.
If controller still does not work, consult factory.
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Glossary of Technical Terms

ACT (All-purpose Calibration Tool) Software
PC software program for configuring and calibrating the APECS controller

Actuator
Device that converts an electrical signal from the APECS controller to an output shaft
position

APECS (Advanced Proportional Engine Control System)
Engine governing system developed by Woodward

Cal File
File containing APECS calibration data

Cal Tool Version
The version of calibration tool software in use

Calibration
Process of configuring and adjusting the controller to work with a specific application

Calibration Wizard
Interactive software guide to help you set up basic calibration and get the controller in
operation quickly

Control Strategy
The version of software residing in the controller

Duty Cycle
Percentage of time a pulse width modulated (pwm) signal remains on

Parameter
Numerical value that helps the user calibrate the APECS controller

PWM (Pulse Width Modulation)

Means of simulating analog output with a digital device. The PWM duty cycle
determines the equivalent analog output: the higher the duty cycle, the higher the
equivalent analog output. A PWM signal is used by APECS to drive the actuator.

Speed Sensor
Device such as a magnetic pickup that senses engine speed
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Chapter 6.

Service Options
|

Product Service Options

If you are experiencing problems with the installation, or unsatisfactory performance of
a Woodward product, the following options are available:

e  Consult the troubleshooting guide in the manual.

e  Contact the manufacturer or packager of your system.

e  Contact the Woodward Full Service Distributor serving your area.

o Contact Woodward technical assistance (see “How to Contact Woodward” later in
this chapter) and discuss your problem. In many cases, your problem can be
resolved over the phone. If not, you can select which course of action to pursue
based on the available services listed in this chapter.

OEM and Packager Support: Many Woodward controls and control devices are installed
into the equipment system and programmed by an Original Equipment Manufacturer
(OEM) or Equipment Packager at their factory. In some cases, the programming is
password-protected by the OEM or packager, and they are the best source for product
service and support. Warranty service for Woodward products shipped with an equipment
system should also be handled through the OEM or Packager. Please review your
equipment system documentation for details.

Woodward Business Partner Support: Woodward works with and supports a global
network of independent business partners whose mission is to serve the users of
Woodward controls, as described here:

e A Full Service Distributor has the primary responsibility for sales, service,
system integration solutions, technical desk support, and aftermarket marketing of
standard Woodward products within a specific geographic area and market
segment.

e An Authorized Independent Service Facility (AISF) provides authorized service that
includes repairs, repair parts, and warranty service on Woodward's behalf. Service (not
new unit sales) is an AISF's primary mission.

e A Recognized Engine Retrofitter (RER) is an independent company that does
retrofits and upgrades on reciprocating gas engines and dual-fuel conversions, and
can provide the full line of Woodward systems and components for the retrofits and
overhauls, emission compliance upgrades, long term service contracts, emergency
repairs, etc.

e A Recognized Turbine Retrofitter (RTR) is an independent company that does
both steam and gas turbine control retrofits and upgrades globally, and can provide
the full line of Woodward systems and components for the retrofits and overhauls,
long term service contracts, emergency repairs, etc.

A current list of Woodward Business Partners is available at
www.woodward.com/support.
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Woodward Factory Servicing Options

The following factory options for servicing Woodward products are available through
your local Full-Service Distributor or the OEM or Packager of the equipment system,
based on the standard Woodward Product and Service Warranty (5-01-1205) that is in
effect at the time the product is originally shipped from Woodward or a service is
performed:

e Replacement/Exchange (24-hour service)

e Flat Rate Repair

¢ Flat Rate Remanufacture

Replacement/Exchange: Replacement/Exchange is a premium program designed for
the user who is in need of immediate service. It allows you to request and receive a
like-new replacement unit in minimum time (usually within 24 hours of the request),
providing a suitable unit is available at the time of the request, thereby minimizing
costly downtime. This is a flat-rate program and includes the full standard Woodward
product warranty (Woodward Product and Service Warranty 5-01-1205).

This option allows you to call your Full-Service Distributor in the event of an
unexpected outage, or in advance of a scheduled outage, to request a replacement
control unit. If the unit is available at the time of the call, it can usually be shipped out
within 24 hours. You replace your field control unit with the like-new replacement and
return the field unit to the Full-Service Distributor.

Charges for the Replacement/Exchange service are based on a flat rate plus shipping
expenses. You are invoiced the flat rate replacement/exchange charge plus a core
charge at the time the replacement unit is shipped. If the core (field unit) is returned
within 60 days, a credit for the core charge will be issued.

Flat Rate Repair: Flat Rate Repair is available for the majority of standard products in
the field. This program offers you repair service for your products with the advantage of
knowing in advance what the cost will be. All repair work carries the standard
Woodward service warranty (Woodward Product and Service Warranty 5-01-1205) on
replaced parts and labor.

Flat Rate Remanufacture: Flat Rate Remanufacture is very similar to the Flat Rate
Repair option with the exception that the unit will be returned to you in “like-new”
condition and carry with it the full standard Woodward product warranty (Woodward
Product and Service Warranty 5-01-1205). This option is applicable to mechanical
products only.
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Returning Equipment for Repair

If a control (or any part of an electronic control) is to be returned for repair, please
contact your Full-Service Distributor in advance to obtain Return Authorization and
shipping instructions.

When shipping the item(s), attach a tag with the following information:
return number;

name and location where the control is installed;

name and phone number of contact person;

complete Woodward part number(s) and serial number(s);
description of the problem;

instructions describing the desired type of repair.

Packing a Control

Use the following materials when returning a complete control:

e  protective caps on any connectors;

e antistatic protective bags on all electronic modules;

packing materials that will not damage the surface of the unit;

at least 100 mm (4 inches) of tightly packed, industry-approved packing material;
a packing carton with double walls;

a strong tape around the outside of the carton for increased strength.

To prevent damage to electronic components caused by

improper handling, read and observe the precautions in
NOT’CE Woodward manual 82715, Guide for Handling and
Protection of Electronic Controls, Printed Circuit Boards,

and Modules.

Replacement Parts

When ordering replacement parts for controls, include the following information:
e the part number(s) (XXXX-XXXX) that is on the enclosure nameplate;
e the unit serial number, which is also on the nameplate.
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Engineering Services

Woodward offers various Engineering Services for our products. For these services, you
can contact us by telephone, by email, or through the Woodward website.

e  Technical Support
e  Product Training
e  Field Service

Technical Support is available from your equipment system supplier, your local Full-
Service Distributor, or from many of Woodward’s worldwide locations, depending upon the
product and application. This service can assist you with technical questions or problem
solving during the normal business hours of the Woodward location you contact.
Emergency assistance is also available during non-business hours by phoning Woodward
and stating the urgency of your problem.

Product Training is available as standard classes at many of our worldwide locations.
We also offer customized classes, which can be tailored to your needs and can be held
at one of our locations or at your site. This training, conducted by experienced

personnel, will assure that you will be able to maintain system reliability and availability.

Field Service engineering on-site support is available, depending on the product and
location, from many of our worldwide locations or from one of our Full-Service
Distributors. The field engineers are experienced both on Woodward products as well
as on much of the non-Woodward equipment with which our products interface.

For information on these services, please contact us via telephone, email us, or use our
website and reference www.woodward.com/support, and then Customer

Support.

How to Contact Woodward

For assistance, call one of the following Woodward facilities to obtain the address and
phone number of the facility nearest your location where you will be able to get

information and service.

Electrical Power Systems

FACILITY PHONE NUMBER
Brazil ------------- +55 (19) 3708 4800
China------------ +86 (512) 6762 6727
Germany:

Kempen --- +49 (0) 21 52 14 51
Stuttgart ----- +49 (711) 78954-0

1300 |- — +91 (129) 4097100
Japan ------------- +81 (43) 213-2191
LT — +82 (51) 636-7080
Poland -------------- +48 12 618 92 00

United States-----+1 (970) 482-5811

Engine Systems

FACILITY PHONE NUMBER
Brazil ------------- +55 (19) 3708 4800
China------------ +86 (512) 6762 6727
Germany:

Stuttgart ----- +49 (711) 78954-0

1316 P— +91 (129) 4097100
Japan ------------ +81 (43) 213-2191
LY —— +82 (51) 636-7080

The Netherlands -+31 (23) 5661111

United States-----+1 (970) 482-5811

Turbine Systems

FACILITY PHONE NUMBER
Brazil ------------- +55 (19) 3708 4800
Chin@------------ +86 (512) 6762 6727
1306 [ p— +91 (129) 4097100
Japan ------------- +81 (43) 213-2191
(Y —— +82 (51) 636-7080

The Netherlands -+31 (23) 5661111

United States-----+1 (970) 482-5811

You can also contact the Woodward Customer Service Department or consult our

worldwide directory on Woodward’s website (Www.woodward.com/support) for the
name of your nearest Woodward distributor or service facility.

For the most current product support and contact information, please refer to the latest
version of publication 51337 at www.woodward.com/publications.
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Technical Assistance

If you need to telephone for technical assistance, you will need to provide the following information.
Please write it down here before phoning:

General
Your Name

Site Location

Phone Number

Fax Number

Prime Mover Information
Engine/Turbine Model Number

Manufacturer

Number of Cylinders (if applicable)

Type of Fuel (gas, gaseous, steam, etc)

Rating

Application

Control/Governor Information
Please list all Woodward governors, actuators, and electronic controls in your system:

Woodward Part Number and Revision Letter

Control Description or Governor Type

Serial Number

Woodward Part Number and Revision Letter

Control Description or Governor Type

Serial Number

Woodward Part Number and Revision Letter

Control Description or Governor Type

Serial Number

If you have an electronic or programmable control, please have the adjustment setting positions or
the menu settings written down and with you at the time of the call.
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We appreciate your comments about the content of our publications.

Send comments to: icinfo@woodward.com

Please reference publication 36513.

> WOODWARD
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Phone +1 (970) 482-5811 e Fax +1 (970) 498-3058

Email and Website—www.woodward.com

Woodward has company-owned plants, subsidiaries, and branches,
as well as authorized distributors and other authorized
service and sales facilities throughout the world.
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